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Contact and Support Information
Return to Table of Contents.

Product information can be accessed by visiting Customer Support online: CCH Axcess Product Support.

In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility for each CCH Axcess™ module. Access to these features is available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes.

Visit the Application Status web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to open a Support case or chat with a representative for assistance.
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https://support.cch.com/productsupport/productsupport.aspx?id=37
https://support.cch.com/Axcess/ReleaseNotes/Tax
https://support.cch.com/appStatus/
https://support.cch.com/Contact


Information in Tax Release Notes
Return to Table of Contents.

CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that were made to Tax
products and systems with the current release.

Information provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (such as, electronic filing updates, Organizer, Roll Forward, and
technology enhancements)
Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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https://support.cch.com/axcess/releasenotes/tax/
https://support.cch.com/axcess/releasenotes/tax/


Highlights for Release 2024-1.0
Return to Table of Contents.

Tax Updates
Below are some of the major changes anticipated for Tax Year 2024. Some items in this list may not be
available in the initial release but will be included in a future release.

Laser Print Suppression. The following authorities require us to suppress the laser printing of forms in a
draft or unapproved version as noted below.

Authorities not allowing draft print of forms or unapproved final version of forms:

Arkansas Montana South Carolina
Georgia New York City Texas
Kansas Oklahoma Virginia
Michigan

All draft or unapproved forms from these authorities will appear in the tax application with a watermark.
However, when printed, all forms will print on a blank page with only input amounts and a watermark to
indicate that the form is not approved for filing until it is final.

Note: Michigan requires us to not show the form in the application until approval is obtained; therefore,
they will appear blank in the application.

Forms Release Status Page. The Forms Release Status page has been updated for Tax Year 2024 with this
release. To view, a login is required for the support site. Please see this Knowledge Base article on how to
register for the site. Projections will be added with Release 2024-2.3, available January 26th, for any
outstanding forms at that time.

Content and Compliance Changes
Consolidated Electronic Filing. An enhancement was added to select electronic filing at the top level of a
consolidated return group and push down the options to the other returns in that group. This enhancement
is only available in the Corporation entity (1120) and in Worksheet View located under Federal >
Consolidated > Consolidated Electronic Filing. Within the tab "Consolidated Electronic Filing Options,"
electronic filing can be turned on/off for the entire return as well as the states. The selections made here
will push down to the other returns in the group reducing the amount of time you have to go in/out of
returns to make these simple selections. Please see this KB article for additional information on this
enhancement. This new feature does not replace the previous input that is still available.

Form 1042, Annual Withholding tax Return for US Source Income of Foreign Persons. This form will be
available in the system for electronic filing for Individual, Fiduciary, Corporation, S Corporation, and
Partnership. Please monitor the Forms Release Status page for availability.

Electronic Filing Updates
Electronic Filing Status System. The Electronic Filing Status System has new columns available on the e-
filing status tab. To add, remove, or rearrange columns in the system, please see this KB article. The
following columns are available to add to this view:
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https://support.cch.com/oss/ml/formstatus/details/axcess
https://support.cch.com/oss/ml/kb/solution/000152772
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Note: Section 965 column options have been removed from the website as they are no longer applicable.

CCH Axcess Common
Backup and Restore Return Process. The Backup and Restore Return(s) processes have updated styling
that is in align with the Return Manager look and feel.

Restore Return(s). The updated Restore Return(s) process provides a more streamlined user experience.
As part of the design, the selection of the returns and the possible updates needed as part of the account
restore, such as Return Group, Office/Business Unit, Return Configuration and Signer can now be made
from one dialog versus the current process of updating each return one at a time. You will still have the
option to update one return at time - via the new grid view option - giving you the choice to make the
updates with the method you prefer.

K-1 Manager
Review and Reclass Screens

Preview K-1 Data: Users can now review K-1 data prior to import, providing greater control
and accuracy.

Edit/Modify Data: Users can make edits or changes to the K-1 data (Parts I & II) before
importing.

Reclassify Lines: Users can reclassify lines from the target K-1 to a different location in the K-
1 1040 worksheet, applicable only to lines with statement details.

View Detailed Statements: Users can view statement details associated with the K-1 data
before importing.

Merge Non-Activity K-1s: Non-activity K-1s can now be merged into a single activity for streamlined
reporting. Users can do this when they are setting up their K-1 to import into the target return.

State Mapping

State Selection: Users can view and select states to import as part of their workflow.

California State Mapping: For this release, California state mapping is supported for Lines 1-12 and 13d.
Additional lines and mappings for other states (Arizona, Arkansas, Colorado, Connecticut, Delaware,
Hawaii, Idaho, Illinois, Indiana, Iowa, Kentucky, Maryland, Montana, Missouri, Nebraska, North Dakota,
New York, Oregon, South Carolina, Utah, and Wisconsin) will be included in on Release 2024-3.4, available
April 27, 2025.

Support
CCH, including support for CCH ProSystem fx Tax, will be closing at 2:00 PM CST on Tuesday, December 24,
2024, through Wednesday, December 25, 2024. Support will be available again at 8:00 AM CST on
Thursday, December 26, 2024. We will also be closed on Wednesday, January 1, 2025, and will resume
support on Thursday, January 2, 2025, beginning at 7:00 AM CST (via Chat). Please see the schedule of
available hours here.
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https://support.cch.com/oss/ml/kb/solution/000212429


If you require support assistance during this time, please enter a web ticket and we will respond when
normal business hours resume.
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https://support.cch.com/oss/ml/contactus


Tax Product Enhancements
Click any of the links below to read about the tax application enhancements included with release 2024-
1.0.

Multiple System Product Enhancements

Individual (1040) Product Enhancements

Corporation (1120) Product Enhancements

S Corporation (1120S) Product Enhancements

Partnership (1065) Product Enhancements

Fiduciary (1041) Product Enhancements

Exempt (990) Product Enhancements

Employee Benefit Plan (5500) Product Enhancements

Estate & Gift (706/709) Product Enhancements

Tax Product Enhancements • 7



Multiple Systems Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal — Multiple Systems
Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.
(1040/1041/1120/1120S/1065/990)

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes (1040/1041/1120/1120S/1065/990):

Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.

Form 4255, Recapture of Investment Credit. Form has increased from one (1) to three (3) pages.
Numerous changes including recapture for elective payment election credits and other credit recaptures
pertaining to the Inflation Reduction Act of 2022 (1040/1041/1120/1120S/1065).

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages
(1040/1041/1120/1120S/1065/990)

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added (1040/1041/1120/1120S/1065/990)

Form 6765, Credit for Increasing Research Activities. Form has increased by two (2) pages. Sections
added are: (1040/1041/1120/1120S/1065/990)

Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 8911, Alternative Fuel Vehicle Refueling Property Credit. Form reduced from three (3) to two (2)
parts. Added Schedule A, Alternative Fuel Vehicle Refueling Property Credit to perform calculation of
credit (1040/1120/1120S/1065)

Form 8933, Carbon Oxide Sequestration Credit. Main form remains at four (4) pages with schedules
added (1040/1120/1120S/1065)

Schedule A. Disposal or Enhanced Oil Recovery Owner Certification

Schedule B. Disposal Operator Certification
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Schedule C. Enhanced Oil Recovery Operator Certification

Schedule D. Recapture Certification

Schedule E. Election Certification

Schedule F. Utilization Certification

Tax Product Enhancements • 9



Individual (1040) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 172, Net Operating Losses (NOLs). The IRS has added a new form this year. This will replace
Schedules A and B (Form 1045), as well as Worksheets 1 and 2 from Publication 536. Projected by the IRS
to be available to file in March of 2025.

Form 1040, U.S. Individual Income Tax Return.

New input added to Federal > General > Basic Data > General > Name of nonresident/dual-
status alien spouse to be treated as a U.S. resident to fill checkbox on Form 1040.

New input added to Federal > Income > Other Income > Miscellaneous Information (IRS 1099-
MISC) > Other > Income type > Digital Assets Received as Ordinary Income. This carries to
Schedule 1 (Form 1040), Line 8v.

Amounts report on IRS 1099-K as personal items sold at a loss and incorrect Form 1099-K items
now carry to a new line added on schedule 1 (Form 1040) before Part I rather than included as
other income and backed out as other adjustments.

Schedule 2 (Form 1040) Part I has been revised by the IRS.

Schedule 3 (Form 1040) Changed from two (2) pages to one (1) page.

Form 8689, Allocation of Individual Tax to the U.S. Virgin Islands. Now carries to Schedule
3 (Form 1040), Line 13z rather than printing beside Form 1040, Line 33.

Form 1040 NR Schedule P, Gain or Loss of Foreign Persons From Sale or Exchange of Certain
Partnership Interests. Is expected to be electronically filed this year.

Form 1042, Annual Withholding Tax Return for U.S. Source Income of Foreign Persons. Form added
and is available for electronic filing.

Form 1042 Schedule Q, Tax Liability of Qualified Derivatives Dealer (QDD)

Form 1116, Foreign Tax Credit. Added automatic calculation in the input when total foreign taxes paid
are entered and the carryover amount field is blank.

Data entry located at Foreign or Credits > Foreign Tax Credit > Part III – Carryovers –
Computation of Foreign Tax Credit and Part III – Carryovers – Computation of Foreign Tax
Credit – AMT, if Different.

Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes:
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Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.

Form 4255, Recapture of Investment Credit. Form has increased from one (1) to three (3) pages.
Numerous changes including recapture for elective payment election credits and other credit recaptures
pertaining to the Inflation Reduction Act of 2022.

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages.

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added.

Form 6765, Credit for Increasing Research Activities. Form has increased by two (2) pages. Sections
added are:

Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 7004, Application for Automatic Extension of Time To File Certain Business Income Tax,
Information, and Other Returns. Added ability to produce and electronically file extension for Form 1042.

Form 7203, S Corporation Shareholder Stock and Debt Basis Limitation. Pro Forma of new fields on
Federal > Income > Sch E, P2 — S Corporation Passthrough (K-1 1120S) > Basis Limitation Information > How
Stock was Acquired.

Form 7206, Self-Employed Health Insurance Deduction. Is expected to be electronically filed this year.

Form 7217, Distributions From a Partnership of Property With Partner Basis Adjustments. Projected by
the IRS to be available to file in March of 2025.

Form 8283. Noncash Charitable Contributions. Data entry redesigned.

Data entry worksheets can now have both Section A and B items entered.

Detailed entries for each item have been enhanced to allow Section B, Part II and electronic
filing statement data entry to be part of each item.

Allows for control as to what information appears on each 8283.

Form 8621, Return by Shareholder of Passive Foreign Investment Company or QEF. The supplement
schedule for excess distributions prints following its corresponding PFIC.

Form 8908, Energy Efficient Home Credit. The IRS has added a page two for Part II, Certifier
Information.

Form 8911, Alternative Fuel Vehicle Refueling Property Credit. Form reduced from three (3) to two (2)
parts. Added Schedule A, Alternative Fuel Vehicle Refueling Property Credit to perform calculation of
credit.

Form 8933, Carbon Oxide Sequestration Credit. Main form remains at four (4) pages with schedules
added.
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Schedule A. Disposal or Enhanced Oil Recovery Owner Certification

Schedule C. Enhanced Oil Recovery Operator Certification

Schedule D. Recapture Certification

Schedule E. Election Certification

Schedule F. Utilization Certification

Form 8936, Clean Vehicle Credit. Schedule A has been expanded to include information on credit
transfers to dealers and recapture of transferred credits.

Form 8990, Limitation on Business Interest Expense Under Section 163(j). Diagnostic added for when
Line 13K of the IRS K-1, 1065 is present, but Form 8990 is not.

Schedule K-1 data entry.

Moved Qualified business income to its own section.

Federal > Income > Sch E, P2 — Partnership Passthrough (K-1 1065) > Qualified Business
Income

Federal > Income > Sch E, P2 — S Corporation Passthrough (K-1 1120S) > Qualified
Business Income

Federal > Income > Sch E, P2 — Fiduciary Passthrough (K-1 1041) > Qualified Business
Income

Expands have been added to existing input for certain K-1 codes on the IRS K-1 1065 & IRS K-1
1120S.

Line 11I/10I — takes you to Federal > Income > Schedule D > Business Property,
Casualties and Thefts

Line 11O/10O — takes you to Federal > Income > Sch D / 4797 / 4684 — Gains and Losses
(1099-B, 1099-S, 2439) > Capital Gains and Losses

Schedule K-3 data entry. Expanded input to add new fields:

Foreign short term capital gain/loss

Foreign long term capital gain/loss

Foreign collectibles (28%) gain/loss

Foreign interest expense – this new field gives an alternative to entering the foreign interest
expense on Federal > Foreign or Credit > Foreign Tax Credit > Part 1 – Foreign Income and
Deduction Adjustments > Other Interest field.

Foreign loss limited in prior year – input available for capital losses subject to basis
limitations, at-risk limitations, and/or passive loss limitations in the prior year:

Short term capital — regular and/or AMT

Long term capital — regular and/or AMT

Collectibles (28) — regular and/or AMT

State Enhancements

Alabama
Electronic filing of estimated tax payments.

Electronic filing of extensions.
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Arizona
Cross reference now available.

California
Form 3872, California Disaster Relief Request for Postponement of Tax Deadlines.

Connecticut
Form CT-1040 REC, Real Estate Conveyance Tax Credit Schedule.

Delaware
Form ATH-RTF, Authorization to Release Tax Information. This replaces Form 8821DE.

Indiana
Electronic filing of amended returns (Release 2023-3.5).

Schedule IN-ABLE, Indiana's ABLE 529A Savings Plan Credit.

Schedule NOL-MOD, Current Year Net Operating Loss Modification Information.

Iowa
Form 100J, Capital Gain Deduction — Capital Stock Election (Release 2023-3.5).

Input available under Iowa > Income/Deductions > Capital Gain Deduction > Capital Gain
Deduction Form 100J.

Michigan — Michigan Cities
Form ILANWAGE, Wages and Excludible Wages Schedule CF-1040. (Release 2023-3.5).

Input available Federal > Income > Wages Salaries and Tips (W-2).

Minnesota

Form NIIT, Net Investment Income Tax.

Form M1PR-SR, Special Refund.

Form M1QPEN, Qualified Public Pension Subtraction.

Form M1RENT, Renter’s Credit.

Missouri — St Louis
Electronic filing of return.

Montana
Form 2, Montana Individual Income Tax Return. Complete redesign of the form.

Removal of Married Filing Separately on the Same Form filing status

Form DE, Montana Profit or Loss from a Disregarded Entity Owned by a Nonresident.
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Form MT WNRE, Montana Working Military Retirement and Survivor Benefit Exemption.

Form NOL-EBL, Montana Net Operating Loss.

North Carolina
Cross reference now available.

Ohio — Ohio Cities
Form IR-25, Columbus Income Tax Return. Includes electronic filing.

Form IR-PV, Payment Voucher — Return, Extension and Estimate.

Oregon
Form OR-VSI, Voluntary Self-Identification.

Oregon — Multnomah
Prepayments for MC40, MC40NP, MET40 and MET40NP are calculated (Tax Year 2023).

Oregon Preparer’s License from Office Manager and Oregon input added (Tax Year 2023).

Rhode Island
Electronic filing of estimated tax payments.

Electronic filing of extensions.

Includes batch processing.

South Carolina
Schedule TC-60, South Carolina Earned Income Tax Credit.

Cross reference now available.

Texas
Add functionality to print extension (Form 05-164) if all state extensions are requested on Federal >
Extensions > Extensions.

Utah
Form TC-40A — Child Tax Credit Worksheet.

Wisconsin
Schedule WI-2441, Additional Child and Dependent Care Credit.

Earned Income Credit calculation for Wisconsin Earned Income.
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Corporation (1120) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Form Changes
Consolidated Electronic Filing. An enhancement was added to select electronic filing at the top level of a
consolidated return group and push down the options to the other returns in that group. This enhancement
is only available in the Corporation entity (1120) and in Worksheet View located under Federal >
Consolidated > Consolidated Electronic Filing. Within the tab "Consolidated Electronic Filing Options,"
electronic filing can be turned on/off for the entire return as well as the states. The selections made here
will push down to the other returns in the group reducing the amount of time you have to go in/out of
returns to make these simple selections. This new feature does not replace the previous input that is still
available.

Form 1042, Annual Withholding Tax Return for U.S. Source Income of Foreign Persons. Form added
and is available for electronic filing.

Form 1042 Schedule Q, Tax Liability of Qualified Derivatives Dealer (QDD)

Form 1120, U.S. Corporation Income Tax Return

Schedule J, Tax Computation and Payment. New lines added:

Line 1b — Tax from 1120-L

Line 1g — Amount from Form 4255, Part I, Line 3, Column q

Line 1z — Other chapter 1 tax

Line 11b — deferred tax on the corporation’s share of undistributed earnings of a
qualified electing fund

Line 11c — Deferred LIFO recapture tax (section 1363(d))

Line 20c — Credit for tax withheld under Chapter 3 or 4 from Form 1042-S, Form 8805,
or Form 8288.

Schedule K, Other Information.

Question 24b — Average annual gross receipts increased to $30 million.

Form 1120-POL, U.S. Income Tax Return for Certain Political Organizations. No longer supported in the
Corporation program and removed this year. This form is available in the Exempt Organization tax program
for paper and electronic filing.

Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes:
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Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.

Form 4255, Recapture of Investment Credit. Form has increased from one (1) to three (3) pages.
Numerous changes including recapture for elective payment election credits and other credit recaptures
pertaining to the Inflation Reduction Act of 2022.

Form 4626, Alternative Minimum Tax — Corporations.

Form increased from seven (7) to nine (9) pages.

Page 8, Part VI — Aggregate Pro-Rata Share of Adjusted Net Income or Loss of CFCs
Described in Section 56A(c)(3) contains two sections.

Schedule A, Aggregate Pro-Rate share of Adjusted Net Income or Loss of CFCs Described in
Section 56A(c)(3).

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages.

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added.

Form 6765, Credit for Increasing Research Activities. Form has increased by two (2) pages. Sections
added are:

Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 7004, Application for Automatic Extension of Time To File Certain Business Income Tax,
Information, and Other Returns. Added ability to produce and electronically file extension for Form 1042.

Form 7211, Clean Electricity Production Credit. New form applicable to fiscal 2024/2025 filers.
Projected to be available post April 15th.

Form 7217, Distributions From a Partnership of Property With Partner Basis Adjustments. Projected by
the IRS to be available to file in March of 2025.

Form 7218, Clean Fuel Product Credit. New form applicable to fiscal 2024/2025 filers. Projected to be
available post April 15th.

Form 8621, Information Return by a Shareholder of a Passive Foreign Investment Company or
Qualified Electing Fund.

Data entry grid expanded to included Elections A through H.

Increase in Tax and Interest Calculations statement prints after the applicable PFIC.

Form 8911, Alternative Fuel Vehicle Refueling Property Credit. Form reduced from three (3) to two (2)
parts. Added Schedule A, Alternative Fuel Vehicle Refueling Property Credit to perform calculation of
credit.
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Form 8933, Carbon Oxide Sequestration Credit. Main form remains at four (4) pages with schedules
added.

Schedule A. Disposal or Enhanced Oil Recovery Owner Certification

Schedule C. Enhanced Oil Recovery Operator Certification

Schedule D. Recapture Certification

Schedule E. Election Certification

Schedule F. Utilization Certification

Form 8990, Limitation on Business Interest Expense Under Section 163(j). Diagnostic added for when
Line 13K of the IRS K-1, 1065 is present, but Form 8990 is not.

Schedule M-3, Net Income (Loss) Reconciliation for Certain Corporations with Total Assets of $10
Million or More.

Calculation logic changed for Worldwide consolidated net income (loss) from income
statement source identified on Part 1, Line 11.

Previously, one or two conditions were required to carry the amount from Part II to Part
I, Line 11. Otherwise a warning diagnostic was produced.

Leaving the Worldwide consolidated net income (loss) from income statement
source field blank at Federal > Sch L/M > Schedule M-3 > General and Net Income
(Loss) Reconciliation or

Selecting Automatically compute worldwide consolidated net income (loss) at
Federal > Sch L/M > Schedule M-3 > General and Net Income (Loss) Reconciliation.

Worldwide consolidated net income (loss) from income statement source identified on
Part I, Line 11 is now calculated automatically.

The selection checkbox changed to Do NOT automatically compute worldwide
consolidated net income (loss) at Federal > Sch L/M > Schedule M-3 > General and Net
Income (Loss) Reconciliation.

State Enhancements

Alabama
Electronic filing of estimated tax payments.

Electronic filing of extensions.

Arkansas
Form AR-718, Arkansas Corporation Special Industry and Alternative Apportionment.

Form AR1100ADJ, Arkansas Corporation Adjustment Schedule — Multistate Corporation.

California
Form 3872, California Disaster Relief Request for Postponement of Tax Deadlines.

Delaware
Form ATH-RTF, Authorization to Release Tax Information. Replaces Form 8821DE.

Electronic filing of extensions with batch processing.
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Georgia
Form IT-QEE-TP2 2024, Qualified Education Expense Credit Computation. (Library Form).

Illinois
Illinois Net Loss Deductions (NLD) for Corporations filing Form IL-1120 is limited to $500,000 for tax years
ending on or after December 31, 2024, and before December 31, 2027.

Bonus depreciation subtraction of 40% added for 2024.

Iowa
Iowa Corporation Schedule H1, Computation of Federal Tax Refund/Deduction. No longer required to
be completed but needs to be filed if IA Corporation Schedule H2, Consolidating Income Statement and IA
Corporation Schedule H3, Reconciliation of Iowa Schedule H2 with Consolidated Federal Return, are
required.

Louisiana
Form R-10610, Schedule of Ad Valorem Credits. Page 1 added to the form.

Massachusetts
Questions for digital dollars were added to various forms.

Michigan
Form 5562, Michigan Direct Debit of Business Tax Payments.

Michigan — Michigan Cities
Form 5562, Michigan Direct Debit of Business Tax Payments.

Missouri — St Louis
Electronic filing of return.

Nebraska
Form 2220N, Underpayment of Estimated Tax for Corporations.

New York
Form CT-663, Commercial Security Credit.

Ohio — Ohio Cities
Form BR-25, City Income Tax Return for Businesses (Columbus). Includes electronic filing.

Oklahoma
Form 200, Franchise Tax. Form is obsolete and removed.
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Oregon — Multnomah
Form C-2024, Multnomah County Business Income Tax and City of Portland Business License Tax.
Electronic filing of amended return.

Form CES-2024, Clean Energy Surcharge. Electronic filing of amended return.

Form METBIT-20, Metro Supportive Housing Services Business Income Tax Return for Corporations.
Electronic filing of amended return.

Rhode Island
Direct debit available for returns and extensions.

Electronic filing of extensions.

Tennessee
Form 170, Franchise and Excise Tax Return. Schedule I added for list of all disregarded Single Member
LLCs included in the return.

Form 174, Franchise and Excise Financial Institution and Captive Real Estate Investment Trust Tax
Return. Schedule I added for list of all disregarded Single Member LLCs included in the return.

Texas
Form 05-163, Texas Franchise Tax No Tax Due Report. Not available for Tax Year 2024 and later.

Effective for reports due on or after January 1, 2024, an entity that has annualized total
revenue less than or equal to the no tax due threshold of $2.47 million is not required to file a
No Tax Due Report. However, the entity is still required to file a Public Information Report
(PIR) or an Ownership Information Report (OIR). The PIR and OIR will still be e-filed without
the presence of the No Tax Due Report.

West Virginia
PDF codes for electronic filing of attachments have been added under Federal > General > Electronic Filing
> PDF Attachments for West Virginia.

Wisconsin
Option to apply manufacturing credit (Sch MA-M) before the research credit (Sch R) is added.

Wisconsin > General > Options > Apply the Manufacturing credit (Sch MAM) before Research
credit (Sch R).
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S Corporation (1120S) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 1042, Annual Withholding Tax Return for U.S. Source Income of Foreign Persons. Form added
and is available for electronic filing.

Form 1042 Schedule Q, Tax Liability of Qualified Derivatives Dealer (QDD)

Form 1120-S, U.S. Income Tax Return for an S Corporation

Schedule K, Shareholder's Pro Rata Share Items

Line 12 — A separate field was added for Cash and Noncash Contributions.

Question 10b — Average annual gross receipts increased to $30 million.

Schedule K-1, Shareholder's Share of Income, Deductions, Credits, etc.

Part II, Information About the Shareholder — Added disregarded Entities and Type of
Shareholder.

Export Option field at Federal > Shareholder > Shareholder Information > Detail > K-1
Export Option is removed and replaced with a checkbox to suppress export per
shareholder.

Schedule K-2/K-3, Shareholders' Pro Rata Share Items — International.

Warning diagnostic (19834) added to compare net income on Schedule K-2, Line 55 to
Page 4, Income (loss) reconciliation, Line 18.

SIC Code input at Federal > Shareholders > Schedule K-2 — Distributive Share Items –
International Parts I-IV > Schedule K-2 Part II Section 2 Deductions now allows a
combination of alphanumeric characters where previously it just allowed numeric.

Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes:

Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.

Form 4255, Recapture of Investment Credit. Form has increased from one (1) to three (3) pages.
Numerous changes including recapture for elective payment election credits and other credit recaptures
pertaining to the Inflation Reduction Act of 2022.
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Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages.

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added.

Form 6765, Credit for Increasing Research Activities. Form has increased by two (2) pages. Sections
added are:

Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 7004, Application for Automatic Extension of Time To File Certain Business Income Tax,
Information, and Other Returns. Added ability to prepare and electronically file extension for Form 1042.

Form 7211, Clean Electricity Production Credit. New form applicable to fiscal 2024/2025 filers.
Projected available post April 15th.

Form 7217, Distributions From a Partnership of Property With Partner Basis Adjustments. Projected by
the IRS to be available to file in March of 2025.

Form 7218, Clean Fuel Product Credit. New form applicable to fiscal 2024/2025 filers. Projected
available post April 15th.

Form 8621, Information Return by a Shareholder of a Passive Foreign Investment Company or
Qualified Electing Fund.

Data entry grid expanded to included Elections A- H.

Increase in Tax and Interest Calculations statement prints after the applicable PFIC.

Form 8911, Alternative Fuel Vehicle Refueling Property Credit. Form reduced from three (3) to two (2)
parts. Added Schedule A, Alternative Fuel Vehicle Refueling Property Credit to perform calculation of
credit.

Form 8933, Carbon Oxide Sequestration Credit. Main form remains at four (4) pages with schedules
added.

Schedule A. Disposal or Enhanced Oil Recovery Owner Certification

Schedule B. Disposal Operator Certification

Schedule C. Enhanced Oil Recovery Operator Certification

Schedule D. Recapture Certification

Schedule E. Election Certification

Schedule F. Utilization Certification

Form 8990, Limitation on Business Interest Expense Under Section 163(j). Diagnostic added for when
Line 13K of the IRS K-1, 1065 is present, but Form 8990 is not.

Schedule M-3, Net Income (Loss) Reconciliation for Certain Corporations with Total Assets of $10
Million or More.

Calculation logic changed for Worldwide consolidated net income (loss) from income
statement source identified on Part 1, Line 11.
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Previously, one or two conditions were required to carry the amount from Part II to Part
I, Line 11. Otherwise a warning diagnostic was produced.

Leaving the Worldwide consolidated net income (loss) from income statement
source field blank at Federal > Sch L/M > Schedule M-3 > General and Net Income
(Loss) Reconciliation or

Selecting Automatically compute worldwide consolidated net income (loss) at
Federal > Sch L/M > Schedule M-3 > General and Net Income (Loss) Reconciliation.

Worldwide consolidated net income (loss) from income statement source identified on
Part I, Line 11 is now calculated automatically.

The selection checkbox changed to Do NOT automatically compute worldwide
consolidated net income (loss) at Federal > Sch L/M > Schedule M-3 > General and Net
Income (Loss) Reconciliation.

State Enhancements

Alabama
Electronic filing of estimated tax payments.

Electronic filing of extensions.

Form 8948-AL, Pass Through Entity Preparer Explanation for Not Filing Electronically.

Arkansas
Form AR1100ADJ, Arkansas Corporation adjustment Schedule — Multistate Corporation.

Form AR1100WHT, Pass-Through Withholding Tax Return Payment Voucher.

Form AR-718, Arkansas Corporation Special Industry and Alternative Apportionment.

California
Form 3872, California Disaster Relief Request for Postponement of Tax Deadlines.

Connecticut
Form CT-PET, Connecticut Pass-Through Entity Tax Return.

Form CT-PET ES, Estimated CT Pass-Through Entity Tax Payment Coupon.

Form CT-PET EXT, Application for Extension of Time to File Connecticut Pass-Through Entity Tax
Return.

Form CT-PET Supp ATT, CT-PET Supplemental Attachment.

Delaware
Form ATH-RTF, Authorization to Release Tax Information. This replaces Form 8821DE.

Electronic filing extensions with batch processing.

Georgia
Form IT-QEE-TP2 2024, Qualified Education Expense Credit Computation. (Library Form)
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Idaho
Form ABE-ES, Affected Business Entity Payment of Business Income Tax. Added for PTE returns.

Illinois
Bonus depreciation subtraction of 40% added for 2024.

Kentucky
Form PTET-P, Pass-Through Entity Tax Underpayment Penalty Calculations.

Louisiana
Form R-10610, Schedule of Ad Valorem Tax Credit. Page 1 added to the form.

Maine
Form 1040C-PV-ME, Maine Composite Income Tax Payment Voucher.

Massachusetts
Questions related to digital dollars were added to various forms.

Michigan
Form 5562, Michigan Direct Debit of Business Tax Payment.

Michigan — Michigan Cities
Form 5562, Michigan Direct Debit of Business Tax Payment.

Missouri — St Louis
Electronic filing of return.

Nebraska
Form 2220N, Underpayment of Estimated Tax for Corporations, S Corporations and Partnerships.

New York
Form CT-663, Commercial Security Credit.

Ohio — Ohio Cities
Form BR-25, City Income Tax Return for Businesses (Columbus). Includes electronic filing.

Oklahoma
Form 200, Franchise Tax. Form is obsolete and removed.

Form 504-PTE, Application for Extension of Time to File an Oklahoma Income Tax Return for Electing
Pass-Through Entities.
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Form 587-PTE, Oklahoma Pass-Through Entity Tax Supplement. Uses Federal input to produce the form
for Tax Year 2024. Pro Forma is updated to move the input in 2024 to the appropriate field.

Form OW-8-ESPTE, Oklahoma Electing Pass-Through Entities Estimated Tax Coupon.

Form EF-PTE, Pass-Through Entities Income Tax Payment Voucher.

Oregon — Multnomah
Form SC-2024, Multnomah County Business Income Tax and City of Portland Business License Tax.
Electronic filing of amended return.

Form CES-2024, Clean Energy Surcharge. Electronic filing of amended return.

Form METBIT-20S, Metro Supportive Housing Services Business Income Tax Return for S-Corporations.
Electronic filing of amended return.

Rhode Island
Direct debit available for returns and extensions.

Electronic filing of extensions.

Form RI-2220, Underpayment of Estimated Tax by Corporate Filers.

Schedule PTE, Pass-Through Entity Election Tax Schedule.

Tennessee
Form 170, Franchise and Excise Tax Return. Schedule I added for list of all disregarded Single Member
LLCs included in the return.

Form 174, Franchise and Excise Financial Institution and Captive Real Estate Investment Trust Tax
Return. Schedule I added for list of all disregarded Single Member LLCs included in the return.

Texas
Form 05-163, Texas Franchise Tax No Tax Due Report. Not available for Tax Year 2024 and later.

Effective for reports due on or after January 1, 2024, an entity that has annualized total
revenue less than or equal to the no tax due threshold of $2.47 million is not required to file a
No Tax Due Report. However, the entity is still required to file a Public Information Report
(PIR) or an Ownership Information Report (OIR). The PIR and OIR will still be e-filed without
the presence of the No Tax Due Report.

West Virginia
Form EPT-100, Elective Pass-Through Entity Tax. Includes electronic filing.

PDF codes for electronic filing of attachments have been added under Federal > General > Electronic Filing
> PDF Attachments for West Virginia.
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Partnership (1065) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 1042, Annual Withholding Tax Return for U.S. Source Income of Foreign Persons. Form added
and is available for electronic filing.

Form 1042 Schedule Q, Tax Liability of Qualified Derivatives Dealer (QDD)

Form 1065, U.S. Return of Partnership Income

Schedule B, Other Income.

Question 32 added — Check this box if an election out of subchapter K under section 761
is being made

Input available at Federal > General > Basic Data > Other Information

Schedule K-1, Partner's Share of Income, Deductions, Credits, etc.

Export Option field at Federal > Partners > Partner Information > Detail > Export Partner
Information to 1040/1041/1065/1120/1120S is removed and replaced with a checkbox to
suppress export per shareholder.

Schedule K-2/K-3, Partners' Distributive Share Items — International.

Part XII — Section 871(m) Tax Liability of a Qualified Derivatives Dealer (QDD). Input
available at Federal > Partners > Schedule K-2 — Distributive Share Items — International Part
IX–XIII.

Warning diagnostic (19834) added to compare net income on Schedule K-2, Line 55 to Page 4,
Income (loss) reconciliation, Line 18.

SIC Code input at Federal > Shareholders > Schedule K-2 — Distributive Share Items —
International Parts I-IV > Schedule K-2 Part II Section 2 Deductions now allows a combination
of alphanumeric where previously it just allowed numeric.

Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes:

Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.
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Form 4255, Recapture of Investment Credit. Form has increased from one (1) to three (3) pages.
Numerous changes including recapture for elective payment election credits and other credit recaptures
pertaining to the Inflation Reduction Act of 2022.

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages.

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added.

Form 6765, Credit for Increasing Research Activities. Form has increased by two (2) pages. Sections
added are below:

Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 7004, Application for Automatic Extension of Time To File Certain Business Income Tax,
Information, and Other Returns. Added ability to produce and electronically file extension for Form 1042.

Form 7211, Clean Electricity Production Credit. New form applicable to fiscal 2024/2025 filers.
Projected available post April 15th.

Form 7217, Distributions From a Partnership of Property With Partner Basis Adjustments. Projected by
the IRS to be available to file in March of 2025.

Form 7218, Clean Fuel Product Credit. New form applicable to fiscal 2024/2025 filers. Projected
available post April 15th.

Form 8621, Information Return by a Shareholder of a Passive Foreign Investment Company or
Qualified Electing Fund.

Data entry grid expanded to included Elections A through H.

Increase in Tax and Interest Calculations statement prints after the applicable PFIC.

Form 8911, Alternative Fuel Vehicle Refueling Property Credit. Form reduced from three (3) to two (2)
parts. Added Schedule A, Alternative Fuel Vehicle Refueling Property Credit to perform calculation of
credit.

Form 8933, Carbon Oxide Sequestration Credit. Main form remains at four (4) pages with schedules
added.

Schedule A. Disposal or Enhanced Oil Recovery Owner Certification

Schedule B. Disposal Operator Certification

Schedule C. Enhanced Oil Recovery Operator Certification

Schedule D. Recapture Certification

Schedule E. Election Certification

Schedule F. Utilization Certification

Form 8990, Limitation on Business Interest Expense Under Section 163(j). Diagnostic added for when
Line 13K of the IRS K-1, 1065 is present, but Form 8990 is not.

Schedule M-3, Net Income (Loss) Reconciliation for Certain Corporations with Total Assets of $10
Million or More.
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Calculation logic changed for Worldwide consolidated net income (loss) from income
statement source identified on Part 1, Line 11.

Previously, one or two conditions were required to carry the amount from Part II to Part
I, Line 11. Otherwise a warning diagnostic was produced.

Leaving the Worldwide consolidated net income (loss) from income statement
source field blank at Federal > Sch L/M > Schedule M-3 > General and Net Income
(Loss) Reconciliation or

Selecting Automatically compute worldwide consolidated net income (loss) at
Federal > Sch L/M > Schedule M-3 > General and Net Income (Loss) Reconciliation.

State Enhancements

Multi-State
Suppress Nonresident State K-1’s. Added ability to suppress the nonresident state K-1’s with input
available at Federal > Common State/City > State Nonresident Information for the following states:

Georgia

Missouri

New Jersey

Oregon

Pennsylvania

Virginia

West Virginia

Alabama
Electronic filing of estimated tax payments.

Electronic filing of extensions.

Form 8948-AL, Pass Through Entity Preparer Explanation for Not Filing Electronically.

Arkansas
AR-718, Arkansas Corporation Special Industry and Alternative Apportionment.

AR1100ADJ, Arkansas Corporation Adjustment Schedule — Multistate Corporation.

AR1100WHT, Pass-Through Withholding Tax Return Payment Voucher.

California
Form 3522, Limited Liability Company Tax Voucher. Added data entry to enter direct debit withdrawal
date if different from Form 568 due date.

Input available at Federal > General > Basic Data > Direct Deposit/Electronic Funds
Withdrawal > Date of annual tax (CA).

Form 3872, California Disaster Relief Request for Postponement of Tax Deadlines.
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Schedule K-1 (565), Partner’s Share of Income, Deductions, Credits, etc. Column (e) California source
amounts and credits are now included on the California Schedule K-1 supporting statements for the
following lines:

Line 11a — Other portfolio income (loss)

Line 11b — Total other income

Line 11c — Total other loss

Line 12 — Expense deduction for recovery property

Line 13d — Total expenditures to which an IRC Section 59(e) election may apply

Line 13e — Deductions related to portfolio income

Line 15c — Credits other than Line 15b related to rental real estate activities

Line 15d — Credits related to other rental activities

Line 17f — Other alternative minimum tax items

Line 18a — Tax-exempt interest income

Line 18b — Other tax-exempt income

Line 18c — Nondeductible expenses

Connecticut
CT-PET, Connecticut Pass-Through Entity Tax Return.

CT-PET ES, Estimated CT Pass-Through Entity Tax Payment Coupon.

CT-PET EXT, Application for Extension of Time to File Connecticut Pass-Through Entity Tax Return.

Form CT-PET Supp ATT, CT-PET Supplemental Attachment.

Delaware
Electronic filing of extensions with batch processing.

Georgia
Form IT-QEE-TP2 2024, Qualified Education Expense Credit Computation. (Library Form)

Hawaii
Hawaii Schedule NP, Allocation of Withholding Payment to Nonresident Partners.

Idaho
Form ABE-ES, Affected Business Entity Payment. Added for PTE returns.

Illinois
Late payment interest calculation added.

Bonus depreciation subtraction of 40% added for 2024.
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Indiana
Added state specific Schedule K-1 worksheet for overriding K-1 amounts on Federal > Partners > Schedule
K-1 Overrides > Indiana Schedule K-1 Overrides.

Kentucky
Form PTET-P, Pass-Through Entity Tax Underpayment Penalty Calculations.

Louisiana
Form R-10610, Schedule of Ad Valorem Tax Credit. Page 1 added to the form.

Maine
Form 1040C-PV-ME, Maine Composite Income Tax Payment Voucher.

Massachusetts
Questions related to digital dollars were added to various forms.

Michigan
Form 5562, Michigan Direct Debit of Business Tax Payment.

Michigan — Michigan Cities
Form 5562, Michigan Direct Debit of Business Tax Payment.

Missouri
Form MO-PTE, Pass-through Entity Income Tax Return. Federal Form 70004 is attached to form when
applicable.

Missouri — St. Louis
Electronic filing of return.

Montana
Added state specific Schedule K-1 worksheet for overriding K-1 amounts on Federal > Partners > Schedule
K-1 Overrides > Montana Schedule K-1 Overrides.

Nebraska
Form 2220N, Underpayment of Estimated Tax for Corporations, S Corporations, and Partnerships.

New York
Form IT-663, Commercial Security Credit.
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North Dakota
Added state specific Schedule K-1 worksheet for overriding K-1 amounts on Federal > Partners > Schedule
K-1 Overrides > North Dakota Schedule K-1 Overrides.

Oklahoma
Form 504-PTE, Application for Extension of Time to File an Oklahoma Income Tax Return for Electing
Pass-Through Entities.

Form 587-PTE, Oklahoma Pass-Through Entity Tax Supplement. Uses Federal input to produce the form
for Tax Year 2024. Pro Forma is updated to move the input in 2024 to the appropriate field.

Form OW-8-ESPTE, Oklahoma Electing Pass-Through Entities Estimated Tax Coupon.

Form EF-PTE, Pass-Through Entities Income Tax Payment Voucher.

Oregon
Added state specific Schedule K-1 worksheet for overriding K-1 amounts on Federal > Partners > Schedule
K-1 Overrides > Oregon Schedule K-1 Overrides.

Oregon — Multnomah
Form P-2024, Multnomah County Business Income Tax and City of Portland Business License Tax.
Electronic filing of amended return.

Form CES-2024, Clean Energy Surcharge. Electronic filing of amended return.

Form METBIT-20, Metro Supportive Housing Services Business Income Tax Return for Prtnerships.
Electronic filing of amended return.

Rhode Island
Direct debit available for returns and extensions.

Electronic filing of extensions.

Form RI-2220, Underpayment of Estimated Tax by Corporate Filers.

RI Schedule PTE, Pass-Through Entity Election Tax Schedule.

Tennessee
Form 170, Franchise and Excise Tax Return. Schedule I added for list of all disregarded Single Member
LLCs included in the return.

Form 174, Franchise and Excise Financial Institution and Captive Real Estate Investment Trust Tax
Return. Schedule I added for list of all disregarded Single Member LLCs included in the return.

Texas
Form 05-163, Texas Franchise Tax No Tax Due Report. Not available for Tax Year 2024 and later.

Effective for reports due on or after January 1, 2024, an entity that has annualized total
revenue less than or equal to the no tax due threshold of $2.47 million is not required to file a
No Tax Due Report. However, the entity is still required to file a Public Information Report
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(PIR) or an Ownership Information Report (OIR). The PIR and OIR will still be e-filed without
the presence of the No Tax Due Report.

West Virginia
Form EPT-100, Elective Pass-Through Entity Tax. Includes electronic filing.

PDF codes for electronic filing of attachments have been added under Federal > General > Electronic Filing
> PDF Attachments for West Virginia.
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Fiduciary (1041) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 172, Net Operating Losses (NOLs). The IRS has added a new form this year. This will replace
Schedules A and B (Form 1045), as well as Worksheets 1 and 2 from Publication 536. Projected by the IRS
to be available to file in March of 2025.

Form 1042, Annual Withholding Tax Return for U.S. Source Income of Foreign Persons. Form added
and is available for electronic filing.

Form 1042 Schedule Q, Tax Liability of Qualified Derivatives Dealer (QDD)

Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes:

Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.

Added tracking capability for credit carryovers located at Federal > Credits > Other Credits
and Credit Overrides > Form 3800 — General Business Carryovers

Added Section 6418 credit transfers to taxpayer (Tax Year 2023) to Federal > Credits > Other
Credit and Credit Overrides > Section 6418 Credit Transfers to Taxpayer

Form 4255, Recapture of Investment Credit. Form has increased from one (1) to three (3) pages.
Numerous changes including recapture for elective payment election credits and other credit recaptures
pertaining to the Inflation Reduction Act of 2022.

Form 4720, Return of Certain Excise Taxes Under Chapters 41 and 42 of the Internal Revenue Code.
Electronic filing was added.

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages.

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added.

Form 6765, Credit for Increasing Research Activities. Form has increased by two (2) pages. Sections
added are:
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Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 7004, Application for Automatic Extension of Time To File Certain Business Income Tax,
Information, and Other Returns. Added ability to produce and electronically file extension for Form 1042.

Form 7203, S Corporation Shareholder Stock and Debt Basis Limitations. Form is available for Partial
Grantor Trust returns.

Form 7217, Distributions From a Partnership of Property With Partner Basis Adjustments. Projected by
the IRS to be available to file in March of 2025.

Form 8621, Return by Shareholder of Passive Foreign Investment Company or QEF. The supplement
schedule for excess distributions prints following its corresponding PFIC.

Form 8858, Information Return of U.S. Persons With Respect to Foreign Disregarded Entities (FDEs)
and Foreign Branches (FBs). Ability to tie the 8858 to a Form 5471, Information Return of U.S. Persons
With Respect to Certain Foreign Corporations. Input available at Federal > Foreign > 8858 — Info Return of
U.S. Persons w/ Respect to FDE’s > 8858 — Info Return of U.S. Persons w/ Respect to FDE’s > Form 5471
number.

Form 8868, Application for Extension of Time to File an Exempt Organization Return. Added ability to
electronically file this form that accompanies Form 1041-A, U.S. Information Return Trust Accumulation of
Charitable Amounts.

Form 8990, Limitation on Business Interest Expense Under Section 163(j). Diagnostic added for when
Line 13K of the IRS K-1, 1065 is present, but Form 8990 is not.

Schedule K-1, Beneficiary’s Share of Income, Deductions, Credits etc.

Statement added to report distribution of Form 3468, Investment Credit, Part I Information on
Qualified Property or Qualified Facility.

Export Option field at Federal > Beneficiaries > Beneficiary Information > Export Beneficiary
Information to 1040/1041/1065/1120/1120S is removed and replaced with a checkbox to
suppress export per beneficiary.

Schedule K-1 data entry.

Moved Qualified business income to its own section.

Federal > Income > Sch E, P2 — Partnership Passthrough (K-1 1065) > Qualified Business
Income

Federal > Income > Sch E, P2 — S Corporation Passthrough (K-1 1120S) > Qualified
Business Income

Federal > Income > Sch E, P2 — Fiduciary Passthrough (K-1 1041) > Qualified Business
Income

Expands have been added to existing input for certain K-1 codes on the IRS K-1 1065 & IRS K-1
1120S.

Line 11I/10I — takes you to Federal > Income > Schedule D > Business Property, Casualties and
Thefts

Line 11O/10O — takes you to Federal > Income > Sch D / 4797 / 4684 — Gains and Losses
(1099-B, 1099-S, 2439) > Capital Gains and Losses

Schedule K-3 data entry. Expanded input to add new fields:
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Foreign short term capital gain/loss

Foreign long term capital gain/loss

Foreign collectibles (28%) gain/loss

Foreign interest expense — this new field gives an alternative to entering the foreign interest
expense on Federal > Foreign or Credit > Foreign Tax Credit > Part 1 — Foreign Income and
Deduction Adjustments > Other Interest field

Foreign loss limited in prior year – input available for capital losses subject to basis
limitations, at-risk limitations, and/or passive loss limitations in the prior year:

Short term capital — regular and/or AMT

Long term capital — regular and/or AMT

Collectibles (28) — regular and/or AMT

State Enhancements

Alabama
Electronic filing of extensions.

California
Form 3872, California Disaster Relief Request for Postponement of Tax Deadlines.

Hawaii
Schedule AMD, Explanation of Changes on Amended Return.

Data located at Hawaii > Other > Schedule AMD > Explanation of changes on Amended Return
fields.

Schedule PTE-U, Upper-Tier Pass-Through Entity Tax Credit.

Iowa
Form IA 128S, Alternative Simplified Research Activities Credit. (Added for Tax Year 2023).

Data located at Iowa > Credits > Schedule IA 128 – Research Activities Credit > Research
activities credit code is 2.

Form IA 130-FID, Iowa Fiduciary Out-of-State Tax Credit Schedule. This replaces Form IA 130.

Kentucky — Kentucky Cities
Electronic filing of extension for Louisville.

Louisiana
Form R-7006, Power of Attorney. Form updated to match new artwork from state.

Form 541V-SD, Fiduciary Income Tax Electronic Filing Payment Voucher.
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Maine
Form 1041ME, Income Tax Return for Resident and Nonresident Estates and Trusts. Added checkbox to
have the preparer name automatically print as Third-Party Designee.

Input available at Maine > General > Basic Data > Carry preparer name to third party designee
line.

Massachusetts
Schedule OJC, Income Tax Paid to Other Jurisdictions.

Added input for 8.5%/12% rate split available at Massachusetts > Credits > Sch CMS, Sch OJC
and Other Credits > Schedule OJC – Credit for Taxes Paid.

Updated credit for taxes paid calculation to account for new 4% surtax.

Maryland
Electronic filing of batch extensions.

Michigan
Input available to override Electing Small Business Trust (ESBT) taxable income.

Michigan > Other > Electing Small Business Trust – Overrides > Federal taxable income of
Electing Small Business Trust – override.

Input available to suppress Part 3 of Form MI-2210, Underpayment of Estimated Tax.

Michigan > Estimates/Underpayments > Underpayment of Estimated Tax > Suppress print of
MI-2210, Part III.

Minnesota
Schedule M1CR, Credit for Income Tax Paid to Another State and Schedule M1CR, Credit for Tax Paid
to Wisconsin. Added Passthrough Entity Tax credit calculation.

Schedule M2NM, Non-Minnesota Source Income. Added Electing Small Business Tax (ESBT) version.

Schedule NIIT, Net Investment Income Tax.

Montana
Form FID-3, Montana Income Tax Return for Estates and Trusts. Complete redesign of the form.

Form NOL-EBL, Montana Net Operating Loss.

Nebraska
Electronic filing capability added.

Form NE Opt Out (FID), Nebraska E-file Opt-Out Record for Fiduciary.

Schedule PTET, Beneficiary’s Share of Nebraska Pass-Through Entity Tax Credit.
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North Dakota
Added input for Tax-Exempt UBTI trust to check the other entity box and fill the description.

Input available at North Dakota > General > Basic Data.

Oregon
Oregon Surplus Kicker Credit applies for this tax year.

Input available at Oregon > General > Basic Data > Line 13–15.

Rhode Island
Electronic filing of extensions.

Includes batch processing.

RI Sch PTE, Pass-Through Entity Election Tax Schedule.

South Carolina
Electronic filing of extensions with batch processing.

Virginia
Electronic filing of estimated tax payments.

Electronic filing of extensions.

Tax Product Enhancements • 36



Exempt Organization (990) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 1120-POL, U.S. Income Tax Return for Certain Political Organizations. Available for paper and
electronic filing.

To generate use Federal > General > Basic Data > General > prepare Form 1120-POL.

Data entry available at Federal > Other Returns > 1120-POL U.S. Inc. Tax Rtn for Certain
Political Orgs.

Form 3468, Investment Tax Credit. Form changed from 10 pages to 12 pages.

Part 1, Lines 1–13 description changed to "Information on Qualified Property or Qualified
Facility" from "Facility Information."

Page 3, Part V changed from "Reserved for Future Use" to "Clean Electricity Investment Credit
Under Section 48E" and contains two sections.

Form 3800, General Business Credit. Form had numerous changes:

Part III, Current Year General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits.

Part IV, Carryover of General Business Credits (GBCs) — columns added for
passive/nonpassive activity credits and was changed to landscape view.

Part V, Breakdown of Aggregate Amounts on Part III for Facility-by-Facility, Multiple Pass-
Through Entities etc. — columns added for passive/nonpassive activity credits.

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Corporations.

Schedule G. Other Information increased to 20 lines, increasing the form to six (6) pages.

Schedule H-1. Pro Rata Share of CFC Adjusted Net Income or Loss for Corporate Alternative
Minimum Tax added.

Form 6252, Installment Sale Income. Form has been added for multiple Schedule A’s, Unrelated Business
Taxable Income from an Unrelated Trade or Business Activities. Form 6252 prints to recap all activities and
per IRS schema rules, only one Form 6252 is electronically filed.

Form 6765, Credit for Increasing Research Activities. Form has been added to the Exempt Organization
software. New sections to the form are below:

Section E. Other Information

Section F. Qualified Research Expense

Section G. Business Component Information

Form 7217, Distributions From a Partnership of Property With Partner Basis Adjustments. Projected by
the IRS to be available to file in March of 2025.
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Form 8582 AMT, Passive Activity Loss Limitations. Prepared for Schedule A, Unrelated Business Taxable
Income from an Unrelated Trade or Business Activities. This applies to 501(c) trust, 401(a) trust, and Other
trust.

Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips.

Form 8911, Alternative Fuel Vehicle Refueling Property Credit.

Form 8990, Limitation on Business Interest Expense Under Section 163(j). Diagnostic added for when
Line 13K of the IRS K-1, 1065 is present, but Form 8990 is not.

All States
State return generation, located at Federal > Common State > State Generation has been redesigned to
accommodate the different types of main forms. There are now three (3) columns instead of one (1)
including:

Generate Annual Reports/Form 5227

Generate Unrelated Business Tax

Generate 1120-POL Tax Return

California
Form 3872, California Disaster Relief Request for Postponement of Tax Deadlines.

Colorado
Form DR 0105, Colorado Fiduciary Income Tax Return. Includes electronic filing.

Form DR 0990, Colorado Exempt Entity Income Tax Credit Return. Includes electronic filing.

District of Columbia
Form D-20, SUB Corporation Franchise Tax Return. Added ability to generate this form when Form 1120-
POL is generated in the Federal return. Electronic filing is available.

Florida
Form F-1120, Florida Corporate Income/Franchise Tax Return. Added ability to generate this form when
Form 1120-POL is generated in the Federal return. Electronic filing is available.

Maryland
Form 500UP, Underpayment of Estimated Income Tax by Corporations and Pass-Through Entities.
Available as a full calculation form.

Form 504UP, Underpayment of Estimated Income Tax by Fiduciaries. Available as a full calculation
form.

Massachusetts
Form PC. This form is no longer available to software providers and has been removed from the software.

Michigan
Form 5562, Michigan Direct Debit of Business Tax Payment.
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Minnesota
Form M4NP, Unrelated Business Income Tax (UBIT) Return. Added ability to generate this form when
Form 1120-POL is generated in the Federal return.

Nebraska
Added and available for paper filing. Electronic filing is not offered by the state.

New Jersey
Removed as updates are no longer provided by the state to software providers.

New York
Form CHAR500, NYS Annual Filing for Charitable Organizations. This form is no longer available to
software providers and has been removed from the software.

Oregon
Form OR-41, Oregon Fiduciary Income Tax Return.

South Carolina
Form SC2220, underpayment of Estimated Tax by Corporations. Available as a full calculation form.

Virginia
Form 500, Virginia Corporation Income Tax Return. Added ability to generate this form when Form 1120-
POL is generated in the Federal return. Electronic filing is available.

Wisconsin
Form #1943, Affidavit in Lieu of Annual Financial Report.

Form #1952, Wisconsin Supplement to Financial Report.

Form U, Underpayment of Estimated Tax by Corporations. Available as a full calculation form.
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Employee Benefit Plan (5500) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 14704, Transmittal Schedule Form 5500-EZ Delinquent Filer Penalty Relief Program (Revenue
Procedure 2015-32). Added late penalty paragraph to transmittal letter.
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Estate & Gift (706/709) Product Enhancements
Return to Table of Contents.

Note: Several items in this list may not be available in the initial release, but will be included in a
future release.

Federal Enhancements
Form 709, United States Gift (and Generation-Skipping Transfer Tax Return.

Form expanded to two (2) pages from one (1)

Amended return checkbox added

Foreign address fields added

Form 709, United States Gift (and Generation-Skipping Transfer Tax Return — Schedule A,
Computation of Taxable Gifts. All pages print in landscape view.

Form 709, United States Gift (and Generation-Skipping Transfer Tax Return — Schedule B, Gifts From
Prior Periods. Added a separate page with separate line entries.

Form 709, United States Gift (and Generation-Skipping Transfer Tax Return — Schedule D,
Computation of Generating-Skipping Transfer Tax. Expanded to two (2) pages and begins as a separate
page.
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